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1 Introduction 

Thanks for your interests in Wondershare Fimora for Mac - the easy-to-use and trendy 

video editing software that lets you produce cool and fancy home movies within several 

steps, even you're beginners. Wondershare Filmora for Mac gives you a helping hand to 

get started with any new movie project by importing and editing your video, adding special 

effects and transitions and sharing your final production on a DVD, mobile device or social 

accounts like YouTube, Vimeo directly.  

NOTE: This guide is for Filmora 8.5 users, visit https://filmora.wondershare.com/video-

editor/ to download the newest Filmora9. 

 

1.1 Wondershare Filmora for Mac at a Glance 

Different from Windows Version, Wondershare Filmora for Mac comes with one video 

editing modes to meet your video editing needs with all the fully-customizable timeline 

editing features to arrange scenes, edit clips, and add vivid polish to your movie. 

After launching Filmora Video Editor, choose an aspect ratio. Your options are 16:9 

(widescreen), 4:3 (standard), 1:1 (square) and 9:16 (portrait). 

 

The interface shown below appears as your default workspace, where you can import, 

arrange, edit and add effects to your media files. The rest of the guide mainly focuses on 

what are those parts for when edit videos with Wondershare Filmora for Mac. 

https://filmora.wondershare.com/video-editor/
https://filmora.wondershare.com/video-editor/
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1. Media Library: The Library is the source for all your media, including video clips, photos, 

and music. It also houses text/credit, filters, overlays, elements, transitions, and split 

screen modes that you can use in your projects. 

2. Toolbar: The toolbar provides easy access to many editing commands, like video 

recording, voiceover, delete, split, crop, rotate, inspector, render, and time code controller. 

The render feature allows you to render your video as you go instead of waiting for when 

you export. This results in a smoother video preview. The Time Code Digits Controller 

lets you enter the exact time code (HHMMSSFF format) you want to jump to. 

3. Timeline/Storyboard: The Timeline/Storyboard is where you assemble the media clips 

for your media files. You can drag the slider in the lower right corner to control Timeline 

view, or click the Fit to Timeline button to adjust all media files within Timeline. While in 

the lower left corner of the interface, you can switch Timeline and Storyboard mode 

. 

4. Preview Window: The Preview Window shows the current video being played on the 

Timeline or Storyboard. Snapshot button can save the frame you want as image on Media 

section automatically; there is also a full screen button for you to preview videos at full 

screen.  
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2 Getting Started 

Now follow the steps below to install and register this software: 

2.1 Download2Uninstall 

If you haven't downloaded the software, go to https://filmora.wondershare.com/video-

editor/ and choose Mac or Windows Version depending on your OS: 

 Install 

1. Double-click the .dmg file that you downloaded. 

2. Follow the instructions on your screen to finish the installing process. 

 Register 

The non-activated version of the program has no function limitations, although there will 

be a Filmora watermark added to your final video. 

To remove the watermark, you need to purchase the software to get the registration code. 

If you haven't got your registration code, retrieve it here. 

After getting the registration code, start the software. 

Click the Register button  on the upper right corner of the program. 

In the pop up window, copy and paste your registration info to it and click Register button 

to finish registration. 

 

 Update 

The Updates menu provides important information about new updates of the program. You 

https://filmora.wondershare.com/video-editor/
https://filmora.wondershare.com/video-editor/
https://store.wondershare.com/shop/buy/buy-mac-video-editor.html
http://support.wondershare.com/registration_help.html
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can check for all product updates there. 

Go to Wondershare Filmora>Check for Updates, several seconds later you will find a pop-

up window telling you which version you are currently using. If you are using the latest 

version, it will show that your version is the latest. Not sure? You can always download the 

latest version on Filmora Mac product page and install, it will replace the previous version 

automatically with the registration record kept intact. 

 

 Uninstall 

Go Finder > Applications > Wondershare Filmora, right click to choose Move to Trash.  

 

file:///F:/video-editor/
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2.2 Create a Project 

Saving project is a necessity when working with Wondershare Filmora for Mac. It's helpful 

if you want to interrupt your work and resume it later or modify the saved project to format 

a new creation quickly. The steps below will explain some project basics. If you don't want 

to save a project file, you can find ways to save and share with different formats, 

devices and platforms here. 

 Create a new project 

In the Splash screen, choose the right project aspect ratio and then click "Create New 

Movie". You can then select one of four potential aspect ratios: 16:9 (widescreen), 9:16 

(portrait), 4:3 (standard), or 1:1 (square). You could also click File > New Project and then 

select your aspect ratio. 

 

Click "IMPORT MEDIA" or the plus button in your media library to import video footage. 

 Open an existing project 

Click File>Open Recent or Open Project 
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 Preview the project or clip 

While creating your movie, you will want to preview your work frequently to see how your 

project is progressing. You may choose to play the entire project or only a part of the project 

to preview changes. 

 To preview the entire project or clip 

Choose the entire project or clip and click Play. 

 To preview part of the project or clip 

Use the Slider to select the starting point of the project or clip and click Play. 

 Undo and Copy/Paste actions 

You can undo last action that you performed while working on your movie by using hotkey 

- Command+Z, copy and paste any file by Command +C and Command+V. 

 Save projects 

You can save projects so that you can edit or complete them later. 

Go File>Save or Save as, you can rename the project file with new tags and saving folder.

 

Note: Wondershare Filmora for Mac project files are saved in *.wsve file format.  
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2.3 Import/Record A Video 

When a project is created, you can now import your media files to the program. 

Wondershare Filmora for Mac enables you to import video shot by any type of digital 

cameras, camcorders, mobile devices, etc. — in all major standard and HD video formats. 

Or you can directly record your video from your webcam. A Media Library is also provided 

for you to organize your media clips so that you can easily and quickly catch assets for 

your projects. Find ways to save and share your recorded or imported video files after 

edited here. 

 Import your media files 

There are 4 ways to add media clips to the library: 

1. Click the Icon in the center of Media Library to add files directly 

 

2. Click the Plus button to add files 

 

3. Go File>Import Media>Add Video/Photo Files or Add Audio Files 
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4. Drag and drop to the Media Library directly 

 Record a video file 

Apart from the videos shot by your digital devices, you can also directly record from your 

webcam. Filmora for Mac comes with a built-in video recording feature, allowing you to 

record videos from your webcam easily. 

1. Right in front of the toolbar above the timeline, navigate to the Media Importer icon

. Click it to enter the Importer window. In the upper left corner, click the Webcam 

icon. 

2. In the pop up Video Recording window, click the red button to start recording and click 

it again to stop recording. Then click OK to save the recorded video file. 

 

The recorded video file will be saved into Media Library automatically and you can drag it 

to the Timeline for editing. 
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 Organize Media Files in Media Library 

When all the media files have been imported to the program, you can use the Media Library 

to organize them. 

 To select media in the Media Library 

 Select one media file: click the Plus icon on the thumbnail. 

 Select multiple media files: left click and choose all the media files, or press Command 

and select any files you like, then drag and drop them to timeline directly. 

 To delete media clips from the Media Library 

In the Library, right click on the clip and click Delete. 

Note: All the clips actually remain in their original location since they are just referenced 

in the Media Library. So if you delete a clip from the library, only the reference is deleted. 

You can still find the actual file in the location where it is stored. 

 To sort clips in the Media Library  

Click the Sort button  , and then select Name, Kind, 

Duration or Date Created. 

Click the dropdown window  to classify media files into video, 

image and audio. 

 To access sample colors or video 

Wondershare Filmora for Mac also provides several sample colors or video, which shows 

on the Media Library as bellow, 
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All folders except the first one can be deleted or add more by clicking the button

.  
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2.4 Keyboard Shortcuts List 

This is a list of keyboard shortcuts that you can use with Filmora (Mac).You can also 

click here to download the list in PDF. 

Application Control 

Command Shortcut 

Hide Application Command-H 

Hide Other Applications Option-Command-H 

Minimize Command-M 

Preferences Command-Comma (,) 

Redo Shift-Command-Z 

Undo Command-Z 

Copy Control-C 

Cut Command-X 

Paste Control-V 

Delete Delete 

Select All Command-A 

Deselect All Shift-Command-A 

Close Windows Command-W 

Quit Command-Q 

Export Command-E 

File/Project 

Command Shortcut 

New Project Control-B 

Open Project Control-O 

Add Video/Photo Files Control-1 

Add Audio Files Control-F 

Save Project Control-S 

Save as Shift-Command-S 

Archive Project Shift-Command-A 

Preview 

Command Shortcut 

Play/Pause Space 

Stop Ctrl + / 

Go to Next Frame Left Arrow 

Go to Previous Frame Right Arrow 

Full screen Alt+Enter 

Snapshot Control-Alt-S 

 

http://pop.wondershare.com/filmora/images/hotkeys-for-filmora-mac.pdf
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Editing 

Command Shortcut 

Trim to Playhead Option–/ 

Crop Shift-Command-C 

Powertool Control-P 

Detach Audio Control-Alt-D 

Mute Control-Shift-M 

Record Voice over Alt + R 

Start/Stop Voiceover Recording Alt-Shift-R 

Show Edit Window Alt-E 

Zoom In Timeline Command–Equal Sign (=) 

Fit to Timeline Shift-Z 

Timeline view Alt-T 

Storyboard view Alt-S 

Media/Resource Library 

Command Shortcut 

Add to Timelime/Apply Alt-A 

Find target Control-Shift-R 

Show Property Alt-P 

Scene Detection Alt-D 

Add a new folder(Album) Control-Alt-N 

Delete folder(Album) Delete 

Upper one Up Arrow 

Under one Down Arrow 

Switch to Media Library Ctrl+1 

Switch to Music Library Ctrl+2 

Switch to Text/Credit Library Ctrl+3 

Switch to Filters Library Ctrl+4 

Switch to Overlays Library Ctrl+5 

Switch to Elements Library Ctrl+6 

Switch to TRANSITIONS Library Ctrl+7 

Switch to SPLIT SCREEN Library Ctrl+8 
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3 Basic Editing Tips for Mac 

3.1 Trim/Split/Rotate/Crop/Join a clip 

After all the media files have been imported, you can now edit them for your movie 

with Wondershare Filmora for Mac. You can arrange clips in the order you want to appear 

in your movie, and "clean up" your video footage, cut out the parts you don't like and keep 

only the best footage to include in your movie and more. 

 Add clips to the Timeline 

Before editing, the clips should be added to the Timeline. There are two ways to do that: 

1.Choose a clip in the Media Library and drag it to the timeline directly. 

2.Click the plus button in the lower right corner of each media file, add to project directly. 

Note: If you want to insert a media file in current files on timeline, you cannot drag and 

drop directly, which may overlay your current media files. Try to drag it to the end of timeline, 

and then arrange the order by dragging on timeline. 

Tips: For easier accessing to the different media clips on the Timeline, drag the slide bar 

to adjust the view size of the Timeline. 

 

You can also click the Zoom to Fit Timeline button  to zoom the view size automatically. 

After add the video to timeline, you can trim/split/rotate/crop/join video or enhance 

the video contrast/saturation/brightness/hue and speed. 

 Trim a Clip 

After drag the video to timeline, you can move the pointer to the edge of video file. After 

the pointer becomes an icon like this:  (I know it's ugly, but that's the best drawing of 

my poor skill), then you can start to trim video. You can trim from the start or end (red line). 

Most of time, you may need split tool to adjust this editing. Trim function can help you 

remove the unwanted parts of videos quickly. As we mentioned above, the green part will 

be removed automatically. 

 Split a Clip 

The split function helps you cut a video to two separate parts. You can delete the part you 

file:///F:/video-editor/
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don't want or save it to use anywhere in your movie. 

Wondershare Filmora for Mac provides two ways to help you split a clip: directly split on 

the Timeline or use the scene detection feature to detect different scenes in a video file 

and automatically break it down into several clip files. 

 

To split a clip directly on the Timeline 

1. Select a clip in the Timeline Viewer. 

2. Drag the Split Maker on either side of the clip to change the length. 

3. Click the Split button or right click and choose the "Split" option  from the context 

menu. 

4. If you want to delete the unwanted segment, click "Delete" button  directly. 

To automatically split a clip using scene detection 

1. Right click on the target video file in the Media Library and select "Scene Detection" 

option. This will open the Scene Detection dialog box. 

 

2. Click "Detect" and after several seconds, the file will automatically be broken down 

into several clip files according to the content change. 

3. Then click "Apply" and the separated clips will appear on the Timeline. You can check 

more details here. 
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 Crop a Clip 

The crop function preserves the selected part of a clip and deletes the unnecessary 

elements. Your video will look much better if you can crop black bars from the sides or 

remove background that doesn't contribute anything to the finished product. To crop a clip: 

1.Select a clip in the Timeline Viewer or Storyboard Viewer. 

2.Right click on the clip and choose the "Crop and Zoom" option or choose the clip and 

click the Crop option . 

3.In the pop up window, stretch and move the rectangle to adjust desired frame area. You 

can also choose from "16:9" or "4:3" to crop the video automatically or resize and reposition 

it manually. 

 

 Rotate or Flip a Clip 

With the rise of smartphone-captured video, you've more than likely come across a few 

videos that were filmed sideways. The Rotate or Flip feature will help you fix it. 

1. To rotate or flip a clip: 

2. Choose clip in the Timeline or storyboard viewer. 

3. Click the Rotate button  on Toolbar to activate Photo Inspector or Video Inspector, 

which depends on your file format. 
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4. Then click the different rotate or flip button to make it happen. 

 

 Join Videos 

If you have shot or downloaded several videos in a sequence, the join function can have 

you put them together in no time. To join videos together, just place all the videos on the 

Timeline in the order and click "Export". Wondershare Filmora for Mac will merge them 

automatically. 

 Ripple Edit 

A ripple edit lets a single edit ripple down through the rest of the movie to ensure everything 

stays in sync and just the way you designed it. All you need to do is to turn on Auto Ripple 

by press the chain icon at the bottom of the timeline. With the auto ripple on, if you add or 

delete an element in the middle of the project, the video with all the added effects will be 

shifted or deleted along as a group. You can click the chain button again to unlock the 

combination. 

 

 Render a Clip 

 
After dropping your video clips into the timeline you will see a red, yellow, or green line on 

top of them. The red line means you need to render the clips for a smoother preview. The 

yellow line means there is a risk of the preview being out of sync, so you may want to 

render your clips. To render a clip, select it in the timeline and then click the Render button. 

After a clip is rendered, the line above it will turn green. 
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3.2 Enhance a Video 

Wondershare Filmora for Mac provides two ways to help you improve the appearance of a 

video or image clip by adjusting its current properties like Brightness, Contrast, Hue, 

Saturation and Speed.   

 To manually enhance a clip 

Double click the image or video clip to activate the Photo or Video Inspector on the Timeline 

or click the Inspector Button  directly. Then drag the sliders to adjust the Brightness, 

Contrast, Hue, Saturation or Speed of the clip. You can watch the Preview Window to see 

how the new settings affect the image after clicking OK. 

 

 To automatically enhance a clip 

You can also check the Enhance box to activate the Auto denoise and enhance

 to the selected object. 
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Note: Click the Reset button  to reset the original color setting of the clip. 

 Modify video playback speed 

To change your playback speed, either drag the speed slider or enter the precise speed 

you want in the speed field. You can also adjust your speed by adjusting the duration of 

your clip in the Duration field. You can make your video up to 100x faster or 0.01x slower. 

 

 Edit Image 

You can add still photos to the video track of your timeline. However, if your video project 

has a 16:9 aspect ratio and your photos don't there will be black bars on the sides of your 

photos. To remove these black bars automatically, go to your Preferences and select a 

Photo Placement Fit (Fit, Crop to Fit, or Pan & Zoom). The Crop to Fit feature crops a photo 

automatically to fit the project's aspect ratio, and the Pan & Zoom tool will add a Ken Burns 

effect. If you want to automatically remove the black bar of just one particular photo, right 

click on it in the video track and select Photo Placement and then choose Crop to Fit or 

Pan & Zoom. 
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 Change image duration 

Once an image is added onto the Timeline, it has default duration of 5 seconds. But you 

may want the image to play for a longer or shorter duration. There are two ways to change 

the duration of the image. 

1. Directly drag the length of the image on the timeline to change the duration. 

2. Double click the image to activate Photo Inspector and enter the Duration time in the 

box. You can click "Apply duration to all" to apply the same duration time to all the 

images in the project. 

 

 Apply Motion effect 

Motion effect can help you turn any still photo to animated one. 

 To add this effect, double click the image on the Timeline to activate Photo Inspector 

and then switch to Motion tab. Here you can double click on any motion to apply it on 

the image. 

 To remove the added motion, right click the thumbnail on the Timeline and select 

"Delete Motion" from the menu. 
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 Take a snapshot from a video clip 

To take a photo snapshot of a video clip and save it as an image file, play the video file and 

pause the video where you want to take the snapshot. Then click the Snapshot button

 below Preview Windows. The image snapshot will automatically be added to the 

Media Library and saved to your working folder. 
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3.3 Edit Audios 

Sound is one of the elements that determine the success of your video 

production. Wondershare Filmora for Mac allows you to add music, and voiceover to your 

project. It also allows you to do some editing on the audio track. 

 Add Audio Files 

You can insert background music, even record and add your own voiceover narration to 

audio track. 

 To Add Background Music 

Select music from Mac: Click the Plus icon button to browse for audio files in your 

computer or directly drag and drop the audio files to Media Library. 

Select music from Filmora Built-in Soundtrack: You can choose a song from Filmora 

built-in Soundtrack library without worrying about copyright issue. Currently, there are 50 

royalty free tracks available, including TENDER & SENTIMENTAL, ROCK, FOLK, 

ELECTRONIC and YOUNG & BRIGHT. You can select the most suitable ones to make 

your video fantastic. 

 

 To Add Voiceover 

On the toolbar above Timeline, click Record  to bring up the Voiceover dialog. Click 

the start button to record and you will have 3 seconds of countdown to start speaking. 

When finished, click Stop. Then the voiceover clip will appear on the Timeline. 

file:///F:/video-editor/
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To start a new record on the Timeline, no need to close the dialog, just move the Time 

Indicator to another position and hit the start button again. 

Tips: It's recommended to do the recording in about 10-second sessions, so that it's easier 

to remove a badly recorded narration and redo it. To remove, just right click the audio clip 

on the Timeline and choose "Delete". 

 Split Audio Clips 

Use the Split Maker to indicate where you want to split the audio clip on Wondershare 

Filmora for Mac. Then right click on the clip and select "Split" or click the Split button above 

on the toolbar. 
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 Adjust Audio Settings 

Wondershare Filmora for Mac also enables you to adjust the default audio settings. Double 

click the audio file on the Timeline to activate Audio Inspector, and then you can adjust 

Pitch, Speed and Volume or add Fade in/out effects. Simply use the slider to tune your 

audio up. You can immediately hear the result. If you are not satisfied, click Reset to start 

from scratch. 

 

 Mute Audio 

To mute the video clip which contains audio track, just right click on the video and choose 

"Mute" from the content menu. 
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 Detach Audio from Video 

To detach audio from video, simply right-click on the video and choose "Detach Audio" —

the detached audio track will automatically appear on the Audio Track. 

 

 Audio De-noise 

Audio de-noise is used to reduce the stationary noise (such as wind noise, current 

noise...etc) from the audio part of the video or the audio file. After you drag and drop the 

video/audio to the video track, please double click the file. If it is a video file: 

1. Go to Audio tab. 

2. Tick the option Remove background noise. 

3. Drag the slider to different levels (Weak, Mid or Strong) to reduce the noise 

accordingly. 

If it is an audio file, please double click it and follow above instructions to reduce the noise. 
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 Audio Equalizer 

Please follow below instructions to use Audio Equalizer (EQ). 

1. Drag and drop the video/audio to the timeline. 

2. Double click the video/audio, go to Audio section to access Audio Inspector window. 

3. You can either directly select the presets in the dropdown list of Equalizer, which 

includes Default, Classic, Dance, Low Bass, Sparkle, Pop, Rock' n' Roll, Soft, Techno, 

Hard Rock, Ska, Country, Acoustic, Folk, Blues, Custom. Or you can 

Select Customize button and access the Customize Equalizer window to adjust the 

gain by dragging the sliders upwards or downwards. 

4. Select Save to save the settings. 

 

 Audio Mixer 

To use the Audio Mixer, please follow these instructions: 

1. Drag and drop all the media(video/audio) files to the timeline. 

2. Select Audio Mixer button. 

 
3. Select the tracks one by one to start customizing, you can roll the small ball along the 
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circle to switch the sound from left channel to the right channel. You can also move 

the cursor upwards or downwards to adjust the gains. For sure, you can input a 

customized DB value to make it more precise. 

4. Plus, you are able to choose Surround(virtual) or Stereo. You just need to drag the 

corresponding tracks to the positions where you need along the Pan. 

5. Select OK to save the settings and go back to the timeline to preview the result. 
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3.4 Insert Transition 

Transitions can help your video move smoothly from one scene to the next 

on Wondershare Filmora for Mac. They can either be applied to single clips or in between 

all clips on the timeline. Effective use of this feature can add a professional touch to your 

creation. If you want to add animation in the first frame, you can use snapshot to screenshot 

the first frame and then drag it to the beginning, double-click it to add motion for it. 

 

 Add a Transition 

To apply the transition to a single video/image, please follow below steps: 

1. Drag and drop the video/image to the first line of the timeline. 

2. Select Transition to access the transition library. 

3. Select one transition style and then drag it to the start (prefix transition) or the end 

(postfix transition) of a video/image on the video track. 

4. You can double click the transition on timeline, and then enter the duration value you 

need. Or you can click and drag its start/end points of the clip forward or backward 

within the video/image. 

Prefix Transition 
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Postfix Transition 

 

In addition to applying the transition to a single clip/image, you can also apply transition in 

between two videos or two images. Please follow below steps to apply it. 

1. Drag and drop the video/image to the first line of the timeline. 

2. Go to Transition tap, select a transition effect and then drag it in between two clips 

or two images. 

3. To change the duration of the transition, double click the transition on timeline and 

enter the duration value you need. Or you can click and drag its start/end points of the 

clip forward or backward within the video/image. 

 

To add a selected transition to all video track clips 

Right click the thumbnail of the selected transition and choose "Apply to All". 

To add random transitions to all video track clips 

Right click the thumbnail of any transition and choose "Random". 

To customize a preset transition 

Double-click a transition effect in the Timeline. Change the value for the number of seconds 

you want transition to take place in between clips. Click "Apply duration to all" if you want 

all the transitions have the same duration time. 
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 Save and Delete Transitions 

You can select your favorite transitions and save them in the "Favorite" folder, so that you 

can quickly find them later. You can also delete transitions that you do not use from the 

project by clicking delete button or right-click to choose delete. 

Save a Transition in "Favorite" Folder 

Select the thumbnail of the transition. Right click on it and choose "Add to Favorites" to 

add the transition in Favorite Library list. 
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3.5 Add Text/Credit 

Wondershare Filmora for Mac lets you easily and quickly create beautiful-looking titles, 

complete with special effects. You can add captions as well as Intro and credit. 

 Add Text 

There are various text presets in the Text Library for you to add animated titles. You can 

also save custom presets. 

To add a preset text to your project 

Go to the Text Library, choose an effect, and drag and drop your effect into the Timeline. 

You could also right click on the text effect and choose "Apply". 

 

You can have up to 5 text tracks. To add text tracks, click the Track Manager icon in the 

upper left corner of your timeline and then enter how many tracks you want. 
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To save your text to Favorite 

Right click a title clip in the Library and click "Add to Favorites". You can access later in the 

Library by choosing Favorites category. 

To delete text 

Right click on the clip on the Text Track in the timeline and choose "Delete". 

 Personalize Text and Add Animation 

You can format your text by changing the font, color, or placing it to a new position 

on Wondershare Filmora for Mac. Superimpose your text on a solid or gradient shape to 

make it stand out. You can also define how long a title clip appears by adjusting the title 

clip duration. 

To enter text 

Double click the clip on the Text Track to activate Title Inspector and enter the text in the 

blank area. Then modify the properties of the title clip by using the different options such 

as font, typeface, size, style, alignment, color and more. 

 

To apply preset 

Go to the Preset tab of inspector dialog box and click a thumbnail to apply the effect. 

To customize text 

The Customize tab contains four options: Fill, Border, Shadow and Background. 

 Fill: You can tick the Fill option and you can choose from "Color Fill", "Image Fill" and 

"Gradient". 

 "Color Fill": Pick the color swatch to set the background color. 

 "Image Fill": Choose from the built-in images or click  to load your own image. 

 "Gradient Fill": Set the start and end color and click an arrow button to set the direction. 
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Tip: You can drag the slide below to set the Blur and Opacity value. 

 Border/Shadow/Background 

Choose the respective options and change the attributes using the dialog box. 

To apply animation 

Go to the Animation tab. Browse and double click a specific preset animation to apply. 

 

Tip: To reset the settings, click the Reset button. 

To change text position in the Preview Window 

In the Preview Window, a blue frame appears around the text. You can click and drag it to 
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the position you want. 

To adjust the duration of text clips 

On the Timeline, drag the edges of the clip. 

 Save custom text as preset 

To save your customized text as presets, please follow below steps. 

1. After you apply the text to the timeline, double click it. 

2. Press Save as Preset at the bottom after you finish the customization, give it a name, 

press Save button. 

 

3. The template will be saved in the folder named CUSTOM under Text tap. You can 

drag it to all the projects for direct use. 
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4 Add Video Effects 

4.1 Filters and Overlays 

Adding multiple filters and overlays give you more creative possibilities for your movie. You 

can superimpose clips over background clips or add frames to your video. 

 Add Filters/Overlays 

Wondershare Filmora enables you to add as many filters or overlays as you want. 

1. In the Media Library, select the filters or overlays that you want to add to your project. 

2. Drag the filter/overlay from the Media Library to the Overlay Track on the Timeline. 

You can add background blur filters to replace the black bars if you are editing a 

'portrait' clip in a 16:9 video. 

 Remove Filters/Overlays 

There are two ways to remove filters or overlays from your project. 

 Select the target filter/overlay in the overlay track and hit Delete on the keyboard. 

 Right click the target filter/overlay in the overlay track and select Delete from the menu. 

 

 Find Filters/Overlays 

All filters/overlays are located in the index section on the left side of the media library. Look 

for the filters by clicking on the albums. 
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 Customize Filters 

Wondershare Filmora allows you to customize effects in different ways, such as by 

changing the duration or effect opacity. 

To change the duration 

The default length is 5 seconds. But you can drag the edge of the icon to change the 

duration. 

 

To change the alpha of the filter/overlay 

The alpha opacity property can take a value from 0-100. A lower value makes the filter 

more transparent. Double click the filter to customize the alpha opacity of the filter. Then 

you can view how your clip looks with the filter applied to it in the Preview Window. 

 

Note: click Reset to go back to the default alpha setting of the filter. 

 Favorite Filters/Overlays 

Right click one filter effect from the list and select “Add to Favorite”. The filter effect will be 

stamped a heart icon. Then you can go to the Favorite category to check your favorite filter 

effects. 
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4.2 Elements & Transitions 

Motion elements and sound effects are fashionable, funny and easy to add. Transition 

effects allow your clips switching from one scene to another in a smoother way. In this 

guide, you will learn: 

 Add Motion Elements to your video 

Navigate to the Element tab in the toolbar, click to enter the element resource library. 

Filmora for Mac offers over 200 different kinds of motion elements for you to choose, each 

adding a different tone and mood to your video. 

1. To add motion elements to your video, simply choose one that you like, and then drag 

it to the PIP track, or video overlay track (just drag the element effect and drop it under 

the video track, a PIP track will be generated automatically.) 

 

2. To remove the element, right click on it and choose “Delete” from the drop down menu 
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3. Save the Element effect to your favorite list for future use. In the resource library, select 

the element effect, right click on it, choose “Add to Favorite” 

 

 Add Transition effects between video clips 

1. To add Transition effects to your video: first drag 2 of your video clips to the video track 

on the timeline and arrange their order as wanted. Then navigate to the Transition tab 

in the toolbar, click to enter the transition effects library. Drag a transition and then 

drop it in between those two clips. You can preview the result in the preview window. 
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2. To delete the transition, right click on it and choose “Delete” from the drop down menu 

 

3. Save the transition effect to your favorite list for future use. In the resource library, 

select the transition effect, right click on it, choose “Add to Favorite” 
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5 Advanced Editing Tips for Mac 

5.1 Pan and Zoom 

Pan and Zoom effect, also called Ken Burns Effect, which is used to apply to the video or 

image and make it slowly zoom in on the subjects of interest and pan from one subject to 

another. Please follow below instructions to apply it. 

 Drag and drop the video/image to the video track (first line of the timeline). 

 select the video/image, right click and choose Crop and Zoom. 

 

 Select Pan and Zoom, you will find two frames marked Start in red and End in blue 

appear over the video clip in the viewer. 

 Select the Start frame, drag and resize it until the beginning of the clip is framed the 

way you need. 

 Select the End frame by following step 3. You can press play button to preview the 

instant result. If it does not meet your need, you can select Reset to do it from scratch. 

 Press OK button to save the settings. 
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Note: The switch button at the right bottom of the viewer enables you to swap the start and 

end area instantly.
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5.2 Video Stabilizer 

Here’s how you can stabilize your video footage in Filmora for Mac. 

 Launch the program and select Create New Project. 

 Import your shaky video into the Media Library and drag it into the timeline. 

 Double click on your video in the timeline to bring up the editing panel. 

 Go to the Stabilization menu in the Video tab and make sure it’s box is checked. 

Click Analyze to start the stabilization process. When the analysis is complete, use 

the Smooth level slider to adjust the stabilizing effect. 

 

 Initially it may seem as if the analysis has created flaws in the edges of your video, but 

that is part of the process. As you increase the Smooth level you will zoom in past 

those flaws and your resulting video will be smoother than the original. 

 If you’re happy with the video in the preview window, click OK. If you’d rather remove 

the stabilization effect, uncheck the box next to Stabilization. 
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5.3 Reverse Playback 

To play your video in reverse, here are some tips for reference: 

1. Launch the program and select Create New movie 

2. Left click IMPORT to import your video to media library 

3. Drag and drop the video to the video track (the first track on timeline) from the media 

library 

4. Double left click the video on the video track and select Play video clip in reverse on 

the window pops up 

 

5. Left click Play button to start creating preview renders. It will play the video in reverse 

after rendering. 
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5.4 Screen Recording 

Here’s how to record your computer screen using Filmora for Mac. 

 Launch the program and select Create New Project. 

 Click Record and choose Record Screen. 

 

 You can customize the screen recording area by choosing between Full 

Screen and Custom in the screen recorder window that pops up. You can also 

choose whether to recoding from a microphone and whether you want to record 

computer system audio. Click either icon to turn these audio tools off. 

 

 Click Settings to get access more settings, such as frame rate. 
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 Left click REC button, then the program will start recording after it finishes counting 

down from 3,2,1. After the countdown, you can press the customized button you set 

in Settings to stop recording. Finally, the recorded video will be dropped in the media 

library automatically. 



Advanced Editing Tips   Color Tuning 

45 
 

5.5 Color Tuning 

Please follow below steps to access Advanced Color Tuning. 

1. Drag and drop the video/image from the media library to the first line of the timeline. 

2. Press , you will see Preset and Adjust two taps in the pop-up window 

If you select Preset, you are provided with different kinds of designed templates, such as 

Custom, Favorites, Common, Film, Vignette and 3D LUT for selection. You just need to 

select the style you need in the dropdown list, choose the template, you will have the instant 

result. 

 

If you select Adjust, you are able to make the fine adjustments through the Histogram as 

below. 

 White Balance 

It is used to adjust the color temperature of the video image to create a specific atmosphere. 

A warmer color shifts light toward the yellows whilst a colder color shifts light toward blues. 

Please follow below steps to adjust it: 

1. Tick the option marked White Balance. 

2. Drag the Temperature slider forward or backward to make the adjustment directly. A 

negative value applies a colder temperature whilst a positive value applies a warmer 

temperature. 

3. Drag the Tint slider to adjust the color level of the video directly. 
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 3D LUT 

A Look-Up Table (LUT) is a file containing math instructions to replace a color by another 

one (short explanation). It’s like a color grading preset. 3D LUTs are used extensively in 

the movie production chain, as part of the Digital Intermediate process. To apply the 3D 

LUT, please follow below steps. 

1. Tick the option marked 3D LUT. 

2. Select a template under None. 

3. If you cannot find the one you need in the dropdown list, you can also download and 

install some free 3D LUT beyond Filmora, and then select Load New LUT to load 

them from your local hard drive. 

 

 Color 

In this section, after you tick the option marked Color, you will be able to adjust the 

Exposure, Brightness, Contrast, Saturation and Vibrance of the video image by dragging 

the sliders manually in each bars. 
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Exposure, which is applied to the video that is over or underexposed. A negative value will 

darken all the colors in the video while a positive value will lighten them. 

Brightness, which is used to adjust the brightness of the whole video. 

Contrast, which is used to adjust contrast or the difference between light and dark areas 

of the video. 

Saturation, which is used to adjust the saturation of color in video. A positive value 

increases the overall intensity of the color while a negative value moves the color towards 

black and white. 

Vibrance, which can cleverly increase the intensity of the more muted colors and leaves 

the already well-saturated colors alone. It also prevents skin tones from becoming overly 

saturated and unnatural. 

 

 Light 

In this panel, you can optimize the light of some areas in video by making the adjustments 

of Highlights, Shadows, Whites and Black. Generally, you just need to tick the option 

marked Light, and then drag the slider from left to right to make the adjustment. A negative 

value increases the Highlight/Shadows/Whites/Blacks while a positive value decreases 

them. 
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 HSL 

HSL, which is short for Hue, Saturation and Luminance. It is used to adjust individual color 

ranges in your video. You just need to tick the option marked HSL, select the color that you 

need to adjust in the video, drag the slider from left to right. 

Hue: It is used to fine tune the purity of a specific color of the video. For example, you can 

change a blue sky (and all other blue objects) from cyan to purple. 

Saturation: It is used to change the color vividness or purity of the color. For instance, you 

can change a blue sky from gray to highly saturated blue. 

Luminance: Changes the brightness of the color range. 

 

 Vignette 

You can apply a custom vignetting effect to your video in this panel. After you tick the option 

marked Vignette, you just need to drag the slide within each bar of this panel to make the 

adjustment. 

Amount: Drag the slider to adjust the amount of the effect. The corners of the video moves 

towards black when you drag the slider to the left, while dragging it right lightens them 

towards white. 
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Size: drag the slider to make the adjustment of size of the vignetting effect. Drag the slider 

to the left will increase the size of the effect, closing in a circle in the center of the video. 

Roundness: drag the slider to adjust the overall shape of the effect. 

Feature: Drag the slider to adjust the edge sharpness of the effect. The edge will be blunt 

when you drag slider to the left, while to right uses more of a gradient. 

Exposure: Drag the slider to adjust the exposure level of the vignetting effect. 

Highlights: Drag the slider to adjust the highlights of the vignetting effect. 

 

 Preview the instant result 

After you make the adjustment for each panel, you can select a mode under Compare 

Before/After to show you the instant result. It supports Side by Side View, Split View-

Left/Right, Split View-Top/Bottom. You can also press Show Original button or 

select Disable Comparison to check the original video instantly. If the final result does not 

meet your needs, press Undo/Redo button at the left corner of the preview window or the 

reset button at the right corner of each panel reset it. 

 

 Save as preset 

If you need to save your color adjustments as preset, please select Save as preset, and 

it will be added to Custom under Preset. Please double click the template to apply it to all 

the projects. 
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5.6 PIP (Video Overlay) 

A video overlay, also known as Picture in Picture (PIP), is an effect where one video clip 

overlaps another video clip. Often one video is shrunk down and played in the corner of 

the other video, like when a screen recording includes face cam footage. 

Using video overlays enables you to simultaneously display two or more video clips on the 

screen. It is a useful technique for creating online tutorials, product demonstrations, and 

gaming videos.  

 Overlaying a Video onto a Background Video 

 Import both your overlay clip and your background clip into the Media Library 

 Drag and drop your background clip into video track one, and then drag and drop your 

overlay clip into a higher numbered video track so it is sitting above the background 

clip. If you only see one video track, a second one will be added when you drag your 

overlay clip into the space above video track one. 

 Adjust the size of the overlay video by dragging its edges and corners in the preview 

window. Adjust the position of your overlay video by dragging it in the preview window. 

 

 To add motion elements above your video clips 

Apart from layering your own video footage or photos above background videos you can 

also choose use the motion elements provided in Filmora for Mac. You can find these 

motion elements under Elements in the top menu. 

To apply a motion element, click on it in the Elements menu and then drag and drop it into 

a timeline track above the video you want it to appear over. To make elements you want to 
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reuse easy to find, you can right click on them and choose Add to Favorites to add the 

elements to the favorite folder. 

 

 To reposition an overlay clip 

Drag the overlay clip to the desired position in the Preview Window. It is recommended 

that you keep the overlay clip away from any text you are using to stop your video from 

looking crowded. 

 To resize an overlay clip 

In the Preview Window, drag the handles around the overlay clip to resize it. You can rotate 

and flip the clip here too. 
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 To compose and apply green screen 

Double click the target overlay clip, you will activate the editing panel, in which you can 

compose and apply green screen to it. 

Apply Green Screen to Overlay Clip 

Choose Green Screen tab, click anyone to apply, click OK to apply. Check this Green 

Screen function in more details here. 

 

Apply Compositing Effects to Blend Videos 

Click into the Compositing tab and select a compositing to blend your main video with your 

PIP clip. You can adjust your opacity depending on how intense or subtle you want the 

effect to be. 
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5.7 Green Screen 

Chroma key, i.e. Green Screen makes a particular color in a clip transparent and shows 

the clip in the Video Track as background. This is the advanced feature of PIP 

on Wondershare Filmora for Mac, if you need the easy feature like add overlay clip to video, 

please check the PIP tutorial. To add this effect, follow the steps below: 

1. Click the Green Screen tab in PIP inspector after double-click the clip on PIP track. 

2. Check up "Green Screen (Chroma Key)" and use the picker tool to choose the color 

to be rendered as transparent in the Preview Window. 

3. In the Intensity level option, move the slider to adjust the range color to be rendered 

transparent. 

 

Besides the Green Screen effect on Wondershare Filmora for Mac, you can also add a 

shadow or border for the overlay clip. 

To add a border to an overlay clip 

In the Green Screen tab, click border options. Check out Gradient Border to choose 

Distance, Opacity and Gradient Color. 



Advanced Editing Tips   Green Screen 

54 
 

 

To add a shadow to an overlay clip 

In the Green Screen tab, click shadow options. Check out Drop Shadow to adjust Distance, 

Opacity and Shadow Color. 

 

To rotate or flip an overlay clip 

Below Preview Window, click the four buttons to flip or rotate your clip. 

 



Advanced Editing Tips   Split Screen 

55 
 

5.8 Split Screen 

Here is the preview screenshot of split screen video and do you want to know how can you 

make it with Wondershare Filmora for Mac.  

 

 Choose Screen Mode 

After import video/photo files in Media Library, you can move to Split Screen tab to choose 

any screen modes like 2, 3, 4, 5, 6 screen mode to create trendy videos right now. I'd prefer 

3 Screen Crawl mode like this. Then drag it to timeline directly to ready for editing. Please 

note that currently the Split Screen only supports up to 6 screen, if you want to display like 

10 screens at the same time, you can try PIP effect. 
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 Drag media file to drop zone 

Double click the mode in timeline to activate the Split Screen Inspector and there would be 

a drop zone shown below, default media folder showing on the left. Please note, you can 

drag one file to different drop zone and set up different start points, or you can drag different 

files to different drop zones too. The media can be photo or video or both video and photo. 

You will notice the tiny toolbar for you to set up start point by dragging in the bottom of each 

drop zone Window. 

 

 Switch Media File and Mute Sound 

If you want to switch another media file, you can drag the file to drop zone directly, it will 

replace with the new one automatically or right click the drop zone file to choose delete 

and then drag a new one. If there is sound/audio/voiceover in your original file, you can 

choose to mute or unmute by click the speaker button showing on each tiny drop zone 

window. The default setting is to turn off all audios. 

 

 Apply Boarder 

If you need boarder to separate different windows with different colors, you can check up 

Apply Boarder below the drop zone and choose the color you like most as follow. After you 

complete this, you can export it directly or add more features.  
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5.9 Automatic Scene Detection 

Most of the time I will only use this function when I don't want to edit videos frame by frame 

with Wondershare Filmora for Mac. Because scene detection can detect the whole video 

and split them all based on different scenes to filter out best parts and split out those 

shaking parts, blur parts and so on. Just one click, what you need to do next is to pick and 

delete the unwanted parts. 

After import the media file, right click to pick up Scene Detection as follow. 

 

Then in pop-up window, click detect. It will detect the whole video automatically, what you 

need to do is wait. It won't take too much time, say several second if your video is under 1 

minute. Now the video is split to different clips as follow. There is a Sensitivity toolbar for 

you to adjust the sensitive level from low to high in the bottom. 

 

Click Apply below, it will move all files to timeline directly. 

Now you can start to pick up those unwanted parts, right click to delete or click the delete 
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box directly to remove them. 

 

If you have multiple works to filter videos, scene detection feature can help you a lot! 
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5.10 Tilt-shift/Mosaic/Faceoff 

Besides the basic editing functions such as Rotate, Crop, Split and Cut,Wondershare 

Filmora for Mac also provides you with more functions like Tilt-shift, Mosaic, Face Off, 

which are included in the Power Tool. 

Power Tool includes four powerful editing effects: Tilt-shift, Mosaic, Face Off and Jump Cut 

at Beats. These tools will help you add professional touch to your videos. 

To access the Power Tool 

Choose the clip on the Timeline and click the Power Tool button  above the Timeline 

or right click the clip and choose "Power Tool" option. A window will appear allowing you to 

apply any of these three effects. 

To apply Tilt-shift effect 

Click Tilt-shift and tick "Apply Tilt-Shift to the clip" check box, and then a focal area appears 

in the image. You can adjust the size of the focal area by dragging the yellow line or adjust 

the tilt direction by controlling the white circle between the two green lines. When all the 

adjustments finished, just click "OK" button. 

 

To apply Mosaic effect 

Click Mosaic and check "Apply Mosaic to the clip", and then click on "Add" button. Now a 

mosaic area appears on the clip. You can move it to the desire position and drag the yellow 

frame to adjust the size. Or drag the Percent slider bar to get the effect you want. When 

finished, just click "OK" to save your editing. 
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To apply Face Off effect 

Click Face Off and tick "Apply Face Off to the clip" check box. Then choose a funny face 

you like and it will be immediately put on the face the program detected. You can preview 

the video by hitting on the Play button, then click "OK" to save the editing. 

 

Note: 

Limited by page, please click the left column to check guide about how to create Green 

screen video, split screen video and overlay video with Wondershare Filmora for Mac. 
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6 Save and Share 

With your project finished, it's time to save and share it on Wondershare Filmora for Mac. 

When you save the project, all the files are combined to create a single video files. You can 

save the movie as a video file to be played on a computer or a mobile device, burn your 

project to a disc, or upload it directly to a YouTube and Vimeo account.  

 Choose a sharing option 

After you finish the project, hit Export, there would be an Export Window for you to choose 

from the following sharing options: 

 Format: Save to a file format that lets you play your movie on computers. 

 Device: Save to a file format that lets you play your movie on mobile devices, game 

consoles, or video players. 

 YouTube/Vimeo: Share your work on YouTube and Vimeo from within the program. 

 DVD: Burn your movie to a disc or save as ISO image file. 

 

 Save to video files for computer playback 

Go to the "Format" tab. In the Profile drop list, choose an option such as AVI, WMV, MOV, 

FLV, MP4, MKV, etc. In the Name box, type a file name. In the Position box, specify the 
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location where you want to save the file. Most of users will pick up different resolutions. 

If you want to adjust the default settings, click the Config button to change settings such 

as Codec, Resolution, Frame Rate, Bit Rate for Video, Codec, Channel, Sample Rate and 

Bit Rate for Audio. 

If everything is OK, click "Export". 

 

 Save to video files for mobile devices 

Go to the "Device" tab. In the Device drop-list, choose an option such as iPhone, iPad, 

iPod, PSP, Wii, Creative, etc. to get the optimized videos for your devices. 
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 Upload to YouTube/Vimeo 

Go to the "YouTube" or "Vimeo" tab. Then click the Sign in button to sign in. If it is the first 

time you are signing in, you will be asked to authorize the connection between 

Wondershare Filmora for Mac (Originally Wondershare Video Editor for Mac) and your 

online account. This authorization allows for the exchange of limited information related to 

the successful upload of your video. If you don't have an existing account, you will be 

prompted to create an account. 

Fill in the necessary information like title, description, quality privacy settings and additional 

tags. 

If everything is OK, click "Export". 

Tip: To log in to a different user account, first click the Sign Out button that appears below 

the YouTube, Facebook and Vimeo images. You can then log in to a different user account. 
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 Burn to DVD 

Go to the "DVD" tab. Then set the DVD parameters like DVD label, Aspect Ratio, TV 

Standard and Video Quality, DVD Disk Type and the DVD Formats such as DVD Folder, 

IOS or DVD Media. 

 

What's more, you can create Menu for your DVD with different templates and customize 

music. After that, click Export to burn your video to DVD or save video to an ISO image file. 
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7 Effects Store 

Filmora's Effects Store provides Mac users with countless visual effects that can be applied 

to videos edited with the Filmora Video Editor. It contains a large collection of visual effects 

such as Blockbuster, Fashion or Explosion which will make your videos visually attractive, 

and even unskilled video editors can add them to their videos effortlessly.  

7.1 Creating an account 

In order to get an effect from the Effect Store, you must first create an account either directly 

from the Filmora Video Editor App or from the website. 

 Creating an account on the website 

Visit Filmora Effects Store at https://filmora.wondershare.com/effects-store/, and then 

locate the Account icon . Once you click on it, you will be asked to insert your email 

and password. You can also login with your Facebook, YouTube or Twitter accounts. 

 

 Creating an account from Filmora Video Editor 

If you just installed Filmora on your Mac and you'd like to add some more visual effects to 

your effects library, click on the Download Arrow icon located in the upper right corner of 

https://filmora.wondershare.com/effects-store/
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the editor's interface, and proceed to create your new account or log in to an existing one. 

 

All effects you purchase or download from the Effects Store become accessible after you 

log in to your account. 

7.2 Browsing the Effects Store 

Our Effects Store contains hundreds of different effects, but it also contains an advanced 

search tool that will enable you to filter effects and locate the one you need for your projects. 

You can search for effects by numerous criteria such as Best Sellers, Free, or by exploring 

categories like Action Cam or VFX. Additionally, you can filter effects by selecting Pack, 

Set or Bundle features. 
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A 'Pack' of effects offers the minimum amount of effects, while a 'Set' usually provides 

several 'Packs. A 'Bundle' contains several Sets at a more affordable price. 

7.3 Purchasing the Effects 

If you would like to buy a Pack, a Set or a Bundle for your Mac version of the Filmora video 

editor, you first need to make sure you are logged in to your account. The next step will 

require you to select the effect or a package you want to buy. Clicking on a Bundle, Set or 

a Pack will redirect you to a new page where you'll be able to see information such as the 

number of effects the package contains, its price and a preview of each effect. 
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Click on the Buy Now button if you wish to proceed with the purchase, this action will take 

you to the Shopping Cart page where you can select the payment method. 

 

Once the transaction is complete, you need to click on the My Account icon, and then 

select My Effects option in order to access your effects. Start the installation process by 

clicking Install, and then click OK when asked to open your Filmora Resource application. 

The effects will be installed automatically through built-in Filmora Effects Store Program. 
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7.4 Free Effects 

The Filmora's Effect Store also offers a number of free effects and in order to be able to 

download them, you might be asked to login to free download the effects. The effect will 

be installed automatically in My Effects. 

 

Visit the website https://filmora.wondershare.com/video-editor/ to 

download and install Filmora for Mac before attempting to download free 

effects. 

https://filmora.wondershare.com/video-editor/
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7.5 Locating Effects in Filmora Video Editor 

Open Wondershare Filmora in Create New Movie mode. 

 

And on the left side of the editor's interface, you'll be able to see all the effects you 

purchased sorted into sections they belong to, such as Overlays, Transitions, Filters etc. 

Each new effect will be marked with a red dot. 

Effects purchased at our Effects Store can only be used in Filmora Video Editor. 

 

7.6 Commercial Use about Effects 

With the business license, you can use Filmora and some of the effects (except music) for 

commercial use. 

In Filmora, there are two types of effects: 
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1. Built-in effects found within the Filmora program (including music tracks, 

transitions, text and titles, sound effects etc.). 

All music tracks provided in Filmora program are for personal use only, and may not be 

used in any way whatsoever in which you charge money. 

Other effects like sound effects, text and titles etc. can be used for commercial use only if 

you purchase a business license. 

2. Add-on Effects sold in Effects store (https://filmora.wondershare.com/effects-

store/).  

A single effect pack or set may include several types of effects, such as text&title effects, 

filters, music, sound effects etc. 

Effect packs sold in Effects Store are all made by Wondershare designers, all rights 

reserved to Wondershare. By purchasing a business license, you can use them for 

commercial use. 

 

 

 

 

https://filmora.wondershare.com/effects-store/
https://filmora.wondershare.com/effects-store/
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8 Remove Watermark for Mac  

Watermark is the only limitation for Wondershare Filmora for Mac free trial version. 

Because I really got hundreds of questions about how to remove watermark on videos, 

today I would like to solve your problems within several minutes. 

Please note that all solutions in this article below is nothing about crack skills and I wish 

you can stay away from that. In a word, the legal way to remove this watermark is to get 

the code at paid or free. 

8.1 How to Remove Watermark on Videos?  

For the paid solution, the first and foremost thing is to save the project file and keep original 

files intact. Project file is not a video format file, it's the exclusive file ended with .wsve for 

preserving all related elements edited on timeline. Saving it, you can further edit your 

previous video with detail elements. However, if you delete all original files or replace them, 

this project file will run errors. 

 

Don't know how to save project file? Check the guide page here. 

Now you can purchase the code from application directly or from Filmora website. 

 

For the free trial version, there would be a Register on the top right corner on the Filmora 

application screen. Click the Register button to get Trail Hint Windows, in which you can 

compare the difference between Free Trial Version and Full Registered Version. 



Filmora User Guide   Remove Watermark 

73 
 

 

Click Buy Now, then a browser window will pop up for you to choose suitable License with 

different checkout methods. Besides the 1 Year Subscription, Lifetime License, you can 

even place multi-user License order or ask for Price Quotes for SMB Enterprise. It is 

recommended to check out with PayPal. Click Check out with PayPal button to login with 

your PayPal account and complete the payment. 

 

Or you can go https://filmora.wondershare.com/video-editor/ to click Buy Now 

and follow the payment procedure we've mentioned above to complete the payment. 

https://filmora.wondershare.com/video-editor/


Filmora User Guide   Remove Watermark 

74 
 

Then go your PayPal email to check box, you will find a default email sent from 

Wondershare System. This is your order number, your purchased product. Below you will 

find the licensed e-mail and Registration Code. 

 

Now let's back to the project file, double click to reopen. Click shopping Cart button, 

Register, input the licensed e-mail and Registration Code you got in email, click Register. 

 

Then a window will tell you that Wondershare Filmora for Mac has been registered! Click 

OK. 

Now the last step is export it with suitable formats. Click and choose different save ways. 
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Now, play back the exported video and you will see the watermark is gone! 

8.2 How to Remove Watermark on Videos (Free)? 

What if you need Free way to get code? That's easy! 

Just join the campaign to write a review about Filmora and win the free Wondershare 

Filmora License. 

Interested? Contact our Support for more detailed information. 
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